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Introdusaun ba jestaun dadus jeoespasial no teknolojia sira ba workshop
formasaun Programa Saude - Timor Leste

Ezersisiu 2: Uza funsionalidade baziku sira husi software GIS (QGIS)

Navega iha Interfase:

@ Untitled Project — QGIS ~ o x
Project Edit View layer Settings Plugine Vector Rsster Database Web Mesh Progessing Help 1
| B [ o -0~ Vg b‘ Qﬂ % ./ l'[: m RYPH V- @ > g
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Coordinate | 14.4374°, 120.7975° |9 Scale|1:215054 |~ | @ Magnifier| 100% @mwnn 00° | ¥/ Render @ppscanze @

Interfase QGIS fahe ba area prinsipal 5:
1. Menu Prinsipal
e Fornese asesu ba karakteristika oioin QGIS nian uza menu ierarkiku padraun ida
2. Layers Panel / Browser Panel
e Painél Kamada sira: iha ne'ebé ita-boot sei haree lista hosi kamada mapa oioin
ne'ebé ita-boot aumenta ona ba ita-boot nia mapa
e Painél Browser: Husik ita-boot atu navega ho fasil iha ita-boot nia sistema arkivu no
jere ita-boot nia dadus.
3. Toolbars
e Fornese asesu ba maioria funsaun sira ne'ebé hanesan ho menu sira, no moés
ferramenta adisionadl sira hodi halo interasaun ho mapa
4. Map View
e Nune'e mds hanaran Map canvas, ida-ne'e maka " negdsiu final" husi QGIS — mapa
sira hatudu iha area ida-ne'e.
5. Status bar
e Fornese ita-boot ho informasaun jerdl kona-ba mapa nia haree, no asaun sira ne'ebé
prosesa ka disponivel no oferese ba ita-boot ferramenta sira atu jere mapa nia haree.
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Rai File Project nian

() *Untitled Project — QGIS

Edit View Layer Settings Plugins Vector Ras|

New

New from Template
Open...

Open From

Open Recent

Close

E Save As...
Save To
Revert...

/ Properties...
Snapping Options...
Impert/Export

i ¢y New Print Layout...

"l New Report...

& Layout Manager...
Layouts
Models
Exit QGIS

?
B save Cures -

Ctrl+N

Sy

Ctrl+0

'e®

Ctrl+Shift+S

»

Ctrl+Shift+P

Ctrl+P

Ctrl+Q
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( Choose a QGIS project file

T <« EXERCISES > EXERCISE 4
Organize v New folder
Name
33 Dropbox DATA
8 This PC LOGO

= Windows (C:) MAP_TEMPLATE
w= New Volume (D:

w= My Passport (E:)

Search EXERCISE_4 »

= FresAgent GoFle

]
©

File name:

Save astype: QGZ files (".qgz)

A Hide Folders

Save Cancel

e QGIS bele salva sesaun sira utilizador nian. (Arkivu QGIS ne’e hanaran

‘projetu’.)

e |ha menu prinsipal, click Project > Save

e Hakerek naran arkivu ida no rai ita-boot nia projetu hanesan arkivu QGZ

(.982)

o Formatu arkivu QGZ maka formatu padraun foun ba QGIS. Ida-ne'e

maka formatu komprimidu ho arkivu .qgs (formatu padraun uluk)

ne'ebé inkorpora iha laran hamutuk ho nia baze-dadus sqlite

asosiadu (.qgd) ba dadus auxiliar.
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Manage Layers Toolbar

VVIREB L ARY- QW B V-

Add Vector Layer

Add Raster Layer

Add Mesh Layer

Add Delimited Text Layer

Add Spatialite Layer
Add/Edit Virtual Layer

Add PostGIS Layers

Add WMS/WMTS Layer

Add WCS Layer

Add WFS Layer

Add Layer from STAC Catalog

New Shapefile Layer

Attributes Toolbar

e |
| i |
]
W —"

'Tﬁ\’-' E s T o &
Identify Features
Open Field Calculator

Toolbox

Show Statistical Summary

Open Attribute Table

Measure Line

Show Map Tips

o -
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Map Navigation Toolbar

Ll -3 = e Ao g% b

Pan Map

Pan Map to Selection
Zoom In

Zoom Out

Zoom Full

Zoom to Selection

Zoom to Layer

Zoom to Native Resolution

Zoom Last

foom MNext

New Map View

New 3D Map View]

New Spatial Bookmark
Show Spatial Bookmarks
Temporal Control Panel

Refresh

. HEALTH
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Browser Tab

Right Click in Toolbar area to add browser
sz OF Other panels to the Desktop -

Prq-| Edik  View Layer Settngs

DEERLG

¥ & &5
c ()

Plugims  Vector  Raster  Databas= Web  Processing  Help

BHLARP

Lm0 -

“abe -‘ ”. '-‘ -x-L. 0, 1 e ’) L.:j
[i n @ WR @O EDE R A e # Molbox
4 = @ ] § R ] ; cadi P -~ Advanced Diginzing
V Browser @ = & v Hrowset
O ST ™0 alrww.v 2)
' & GPS Information
o ‘ Home D d D Meraity Resuls
Favaurites rag an rop oy o
.c { < Layer oioer
» issal onto Canvas o tayer
, PostGIS Log Messages
o talto >
555 ;‘:‘752 ) Qverven
R @ wes Spatial Bookmarks
0 wrs Statistics
Q | @ wes Tile scale
Unao/Redo
i' User mput
‘Yé ¢ Advanced Dsgitaing
v Attrbutes
,l) < Databate
Digitizing
A
f: i < Hie
¥ Help
v Lahel

< Manage Layars
< Map Navigaton
v Bugins

\ﬂ Raster
Ractangles, ovaks digitizing tools
i ©rcrzer | 13E |

< Vactar
B Coordinate

< Vieb

711639,2418515 Scale | 12172006 [ e @ ersc2cans o @

From the Manage Layers Toolbar and the Browser Panel you
can add Shapefiles, Databases, WFS, WMS, and several
other types of files.

b Browser Tab
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Project Properties

() *Untitled Project — QGIS

Edit View Layer Settings Plugins Vector Raster D

" New

New from Template
Open...
Open From
Open Recent
Close

[ Save

[ Save As...
Save To
Revert...

B Properties...
Snapping Options...
Import/Export

I} New Print Layout...

) New Report...

'+: Layout Manager...
Layouts
Models

Exit QGIS

Ctrl+N

Ctrl+O

Ctrl+S
Ctrl+Shift+S

Ctrl+Shift+P

Ctrl+P

Ctrl+Q

Q

() Project Properties — General

R General

a Metadata

View Settings

a

"HE e e

8

=TI QGIS Server

” Temporal

I levation
e Elevatior

[

CRS

Transformations

Styles

Colors

Data Sources

Relations

Variables

Macros

Sensors
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&———— Project file name; Project home; Map Measurements

Allows detailed metadata to be defined

Provides means to control the project map canvas

Helps set the coordinate reference system of the project
Helps control the layers reprojection settings

Allows to configure symbols and colors

Allows to choose the color model of the project

Allows to configure the editing behavior & layer capabilities
Used to define relations between layers

Allows to manage project-level variables

Used to edit Python macros

Allows to configure project in order to publish it online

Used to set the temporal range of the project

Helps configure default settings for the terrain and elevation

Used to configure sensors and toggle their connection status

Propriedade Projetu nian permite atu muda konfigurasaun padraun sira ba ATUAL projetu QGI
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Panels and Toolbars

v

O'ummeuvvn;m Qals
Project Edit Leyer Seftings Plugins Vectgr Raster Databsse Web Mesh Dme;smg H!\p

E E © New Map View Ctrl+M ' ﬁ @ %
" (T

30 Map Views >

] 50 panap

Pan Map to Selection

o

(/

Layers
# Zoomln CerloAltes

Panels and Toolbars:
* Turn them on and off by going| =" ™~z

@, identify Features Ctrl+Shifts |

to View > Panels or Toolbars — b
* Panels provide interactive

“windows”. Examples: Layers,

Browser, GPS Information 8 roemti

. Decorations >
* Toolbars are a grouping of e :
1, New Spatial Bookmark... Ctrl+B

tOO IS " Show Spatial Baokmarks Cerl+Shift+B

¥ Show Spatial Bookmark Manager

* Panels/Toolbars can also be 2 reren

Elevation Profile

oom Full Ctrle ShifteF
Ctrle)

oom to Native

Layer Visibility ‘
added/removed by right- s [F—
clicking on the toolbar area Ty nr | apnpomeprme e

Toggle Map Only Ctrl+Shift Tab GPS Information Panel

then checking/unchecking the

Layer Styling Panel
Layers Panel

desired panel or toolbar

Overview Panel

<

Processing Toolbox Panel

Results Viewer Panel

€4 Search QMS Panel

Spatial Bookmark Manager Panel

Statistics Panel

Temporal Controlier Panel
el Tile Scale Panel

Undo/Redo Panel

Vertex Editor Panel

Progessing  Help
Panels —

,u Z % ‘u 71 || Advanced Digitizing Panel
~ Browser (2) Panel
! Browser Panel
Debugging/Development Tools Panel
GPS Information Pancl
Layer Order Panel
Layer Styiing Panel
! Layers Panel

Log Messages Panel
0g Messages Panel - Panels

on top

Overview Panel
Processing Toolbox Panel
Results Viewer Panel

(@} Search QMS Panel
Spatiel Bookmark Manager Panel
Statistics Panel
Temporal Centroller Panel
Tile Seale Panel
Undo/Redo Panel

Vertex Editor Panel

v
J\

Toolbars
Advanced Digitizing Toolbar
Annotatiens Toolbar
| Attributes Toolbar
Data Source Manager Toolbar

Database Toolbar

<

Digitizing Toolbar
Help Toolbar
Label Toolbar

<

Manage Layers Toolbar - Toolbars
Map Navigation Toolbar at the
Mesh Digitzing Toolbar bottom

< &

<

Plugins Toolbar

<

Project Toolbar
Raster Toolbar

<

Selection Toolbar
Shape Digitizing Toolbar
Snapping Toolbar

Vector Toelbar

/| Web Teelbar =
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Vector Layer Properties

(@ *Untitled Project — QGIS (2 Layer Properties — TOLKIEN_BRG — Inf
Project Edit View Layer Settings Plugins Vector Raster Datab: I Q 1
= L 14 [ — T - |
D EE @ ma t\j}% j F(L:" D9 @ - < Read-only summary of information and metadata on the current layer
@ E} ﬁ) F} ;) g) )ca UQ £ 753 “,“\\ Source Used to define general settings for the vector layer

Eees es ¥ symbology Provides a comprehensive tool for rendering and symbolizing vector data
@l ® V&3O

€ Labels

4 ] TOLKIEN BRG i
# Zoom to Layer(s EED Masks Helps configure the current layer symbols overlay with other symbol layers or labels
Zoom to Selection

Provides the capabilities to configure smart labeling on vector layers

©2 Show in Qverview N 30 View Provides settings for vector layers that should be depicted in the 3D Map view tool
Show Feature Count 'I Diagrams Allows to add a graphic overlay to a vector layer
@d Show Labels
Copy Layer E Fields Provides information on fields related to the layer and helps organize them
Rename Layer ! Attributes Form Helps set up the form to display when creating new features or querying existing one
Duplicate L .
L Duplicate Layer Joins Allows to associate features of one layer to features from another loaded vector or table
[l Remove Layer...
= Open Attribute Table ﬂ Ausxiliary Storage Allows to store properties for layers that are not editable
#/ Toggle Editing B Actions Provides the ability to perform an action based on the attributes of a feature
Filter... ~ . . . I
Change Data Source... - Display Helps configure fields to use for feature identification
Set Layer Scale Visibility... ‘--’ T Allows to set the scale dependent visibility and simplify geometry
Layer CRS ’ a Temporal Provides options to control the rendering of the layer over time
Export ’

Styles N Variables Lists all the variables available at the layer’s level

Add Layer Notes...

:'.I Elevation Provides options to control the layer elevation properties within a 3D map view

!‘ Metadata Provides options to create and edit a metadata report on a layer

ﬁ Dependencies Allows to declare data dependencies between layers
Legend Provides advanced settings for the Layers panel and/or the print layout legend

ST QGIS Server Consists of Description, Attribution, MetadataURL, and LegendUrl sections

B oigitiing Gives access to options that help to ensure the quality of digitized geometries

Janela Propriedade Kamada (Vetor) nian fornese informasaun kona-ba kamada vetor nian no fornese
konfigurasaun jeral sira hodi jere aparénsia hosi karakteristika sira kamada nian iha mapa (simbolojia, rétulu ka
label, diagrama sira) no interasaun ho rate (asaun sira, pontu sira mapa nian, dezefiu formulariu nian).
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Data Projections

(@ *Untitled Project — QGIS
Project Edit View Layer Settings Plugins Vector Raster Databs

NEERRY N-5-G-0
VS LLRPP M Q00348

Layers @
o il ® V&~ i O

4 [ TOLKIEN BRG
() Layer Properties — TOLKIEN_BRG — Source X

1) Zoom to Layer(s)

W Sattings

Zoom to Selectio | Q

2 Show in O . . . - ! "
@ R ! G Information ) OV

Show Feature Count Data source enceding | UTF-8 -

"("@ Source

@1 Show Labels = v Assigned Coordinate Reference System (CRS)
Copy Laver & Symbology
Py Lay! EPSG:4326 - WGS B4 h %
Labels
Rename Layer 3 Labe Changing this option does not modify the original data source or perform any reprojection of features. Rather, it can be used to
) override the layer's CRS within this project if it could not be detected or has been incorrectly detected.
D Duplicate Layer €D Masks The Processing Reproject Layer” tool should be used 1o reproject features and permanently change a data source’s CRS,
[4 Remove Layer... & 20 View
- = ¥ Geometry
Open Attribute Table -
N Diagrams Spatial Index Bxists| | Update Extents
J/ Toggle Editing -
Filter... ﬁ Filde W Provider Feature Filter
Change Data Source... Attributes Form
Set Layer Scale Visibility... e
Layer CRS » 3
24 ﬂ Auxiliary Storage
&
Export ’

B s

Styles »

Add Layer Notes... - Display
Query Builder
& oo

Variables

= Style - oK Cancel Apply Help

Kamada vetor/raster hotu-hotu iha projesaun ka Sistema Referénsia Koordenasaun (CRS). Maneira lalais liu atu
verifika projesaun sira maka klik liman-loos iha layer > Properties... > Source tab.
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Raster Layer Properties

(@ *Untitled Project — QGIS | G} Layer Properties - pop_c

Project Edit View Layer Settings Plugins Vector Raster Database ["7\‘ | ]

DB EEY NGB

‘ @ Information ~€——Read-only summary of information and metadata on the current layer

S LLPRAPPPRLABS ) Displays basic information about the selected rast
5 isplays basic information about the selected raster
© Q-' @ % A\ Source play:
D ol ¥ symbology Allows to control how the raster layer is rendered on map
A" T 0 -BAOL

= TG L@ Tronsparency Provides capabilities to set the transparency level of the raster layer

Band 1 (Gray)
2403 T8 Show in Overview €3 (apels

;:' Zoom to Layer(s)

Provides the capabilities to configure smart labeling on raster layer
Copy Layer

Rename Layer BB istogram Allows to view the distribution of the values in the raster
,(‘J Zoom to Native Resolution (100%)
4 Stretch Using Current Extent
D TOLKIEN_B| % Load Raster Attribute Table from VAT.DBF
L) Duplicate Layer c Temporal Provides options to control the rendering of the layer over time
[l Remove Layer...
Move to Bottom MR Pyramids Allows to build pyramids to improve raster performance

Change Data Source...

4 Rendering Allows to set scale dependent visibility and refresh layers at interval

Set Layer Scale Visibiity.. :-l Elevation Provides options to control the layer elevation properties within a 3D map view

Layer CRS 3 "
Export , n Metadata Provides options to create and edit a metadata report on a layer
Styles » L]

Add Layer Notes...

Legend Provides advanced settings for the Layers panel and/or the print layout legend

. Display Helps to configure HTML map tips to use for pixel identification
E Attribute Tables Allows to convert symbology to and import an attribute table

2T QGIS Server Helps to configure settings of the data when published by QGIS Server

Janela (Raster) Layer Properties fornese informasaun kona-ba kamada no més abilidade atu tau nivel piramide
sira, ajusta aparénsia, no haree histograma.
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Layout Manager

(2 *Untitled Project — QGIS

Edit View Layer Settings Plugins

Vector

N N
New from Template
Open...
L Open From
Open Recent
Close

[ Save

2 Save As..
Save To
Revert...

/ Properties...
Snapping Options...
Import/Export

I'2) New Print Layout...
+) New Report...

Layouts
Models
Exit QGIS

Ctrl+N

Ctrl+O

Ctrl+S
Ctrl+Shift+S

Ctrl+Shift+P

Ctrl+P

B8 Layout Manager...

Ctrl+Q

»

>

>

. P

Rast
ok
0]

Layout Manager permite ita-boot atu kria layout mapa foun ida tantu husi layout mamuk ka modelu ida. Bele

MORU . HEALTH
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:/\g/ )

Y@

4 Layout Manager O X
’ Q search
She Duplicate Remove Rename
w New from Template
Empty Layout v Create...

ERCISES\EXERCISE_4\MAP_TEMPLATE\Exercise3_Portrait_Orientation.qp

Open template directory

User

Default

4 Create Print Layout

Enter a unique print layout title
(= title will be automatically generated i left empty)

| OK Cancel Help

asesu husi Project menu (Project > Layout Manager...) or iha janela Print Layout nian (Layout > Layout

Manager...).

10
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Print Layout

| @ "New 1) - o X
Layout Edit View [tems Additenvdlas Settings

BERRRDB R oklhoeo Blee): e iR

PLPNT BRI R G B MAL |

J LU N Pl LI ' L) H LU LB LU Ilinl L) | ) Iliwl vl LU LS ) LU ) Flml sl v le L} Im & mw, |

)| - items @ e
HEURE * @ 1enC

SE B O o mAp TITLE 7 O = e &

re=si| 2 Legend v - Legend

5 £ oz v ] MAP TITLE

R- A v I Map1

R = - —

W

C1E A >

8- =) O o 1 2mm \ | ItemPropertes = Guides

-~ Yig= p— — ltem Properties e®
- ~
. v Main Properties

b g —

é : Sae s &

;v 1 : - & Map rotation |0.00 © 3 (=
| R @ |mepomcs - [®

¥ = V' Draw map canvas items -
llitemsdeded x: 310.903 mm y: 98.3803 mm page: 1 48.7% :' B

Print Layout interface: 1. Menu Bar; 2. Toolbar; 3. Map Layout; 4. ltems and Command History; 5. Layout
Properties; 6. ltem Properties
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Layout Toolbar Navigation Toolbar

XA

e Save project e Zoomin

e New layout e Zoom out

e Duplicate layout e Zoom to 100%

e layout manager e Zoom full

e Add items from template e Refresh view

e Save as template

e Add Pages...

e Print Layout

e Export asimage

e Export as SVG...

e Export as PDF...

e Undo

e Redo

12
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Print Layout
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> Click on the Add Map button then draw a rectangle
for where the Map Canvas will appear.

(@ *Print Layout - o X
Layout Edit View [tems Additem Atlas Settings

BERLREE R ®RiGphoo @lee): (90 HR

ALANC BRE LS E hE]

JulllPllulllilllsolllllllurlliwlvllouvlllslotlultntch:Orch'nnlp?oilll||||-P?0|-| Items l.hdol-Btnrv

@ : Items 2%
0 ° @ lem

= ) 1S = v ] Map 1

N

B S
L -

7] E
& - Layout = ItemProperties | Guides

8- o O Item Properties e®

= : Map 1

M| - w Main Properties 2
2:—0 .é_t Update Preview
o —E Scale 425806 =8

‘*‘h E Map rotation | 0.00 ® s €
/:;g‘ - - . CRS Use project CRS - ||

o V' Draw map canvas items

1 item selected X: 291,336 mm y: 100,554 mm page: 1 48.7% vig)
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Map Elements

Add map elements by clicking on the icons on
the toolbar or in the Add Item menu

This area keeps track of changes
and allows you to customize map <

elements.
Q@ *New - o X
Layout Edit View It tlas Settings
3 o i 35 B FaT A -
BRLR® oLyl e @ e ¢ P> ) & i R
LPLAHLC BB L QLR htHE]
J P 1 FO | |100 | Vo |1?°. 1l FOO | FSO | ‘e PQOJ. ] Items | Undo History
@ 3 ftems [ |
D [e2 ® @ Item
2> 3 . = v r= <Picture> [}
ﬁ - L) MAP TITLE v ww <Scalebar>
=) ot v & Legend
e | = may tm 90 v T| MAP TITLE
e - =
8: D:'an v £ Map1
: B M Kanpong-Ovn
2] &
] 0‘57-: i e 8 =m Layout | ItemPropertes | Guides
_Nc B E : Item Properties @x
7 = Bee t ~
y d w Main Properties
g -
it Update Preview
Q|- =
: < Scale 546475 L =°
x.,b -5 = a ‘i:
/q E - O - Map rotation | 0.00 S =
va g - CRS Use project CRS v||®
¥ =3 V| Draw map canvas items -~
1 item selected x: 310,903 mm y: 98.3803 mm page: 1 48.7% v )

Bainhira mapa aumenta ona, elementu mapa sira seluk bele aumenta. Sira nia propriedade sira, no mds propriedade sira pdjina nian,
bele haree no modifika. Print Layout akompafia mudansa sira iha janela Undo History.

14
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Layout

e Set the grid spacing and snap
tolerance

e Export settings

e Resize layout to content

Item Properties

e Set the font
e Set scale bar properties
e Setlegend properties

e Set map element properties
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